
USER MANUAL



2

Information in this manual is subject to change without notice and does not represent a commitment on
the part of Applied Acoustics Systems DVM Inc. The software described in this manual is furnished under a
license agreement. The software may be used only in accordance of the terms of this license agreement. It is
against the law to copy this software on any medium except as specifically allowed in the license agreement.
No part of this manual may be copied, photocopied, reproduced, translated, distributed or converted to any
electronic or machine-readable form in whole or in part without prior written approval of Applied Acoustics
Systems DVM Inc.

Copyright c© 2005 Applied Acoustics Systems DVM Inc. All rights reserved. Printed in Canada.

Program Copyright c© 2005 Applied Acoustics Systems, Inc. All right reserved.

String Studio VS is a Trademark of Applied Acoustics Systems DVM Inc. Windows 98, 2000, NT,
ME, XP and DirectX are either trademarks or registered trademarks of Microsoft Corporation. Macintosh,
Mac OS, QuickTime and Audio Units are registered trademarks of Apple Corporation. VST Instruments
and ASIO are trademarks of Steinberg Soft Und Hardware GmbH. RTAS is a registered trademarks of
Digidesign. Adobe and Acrobat are trademarks of Adobe Systems incorporated. Unauthorized copying,
renting or lending of the software is strictly prohibited.

Visit Applied Acoustics Systems DVM Inc. on the World Wide Web at

www.applied-acoustics.com



Contents

1 Introduction 7

1.1 System requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

1.2 Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

1.3 Authorization and Registration . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

1.3.1 Unlocking String Studio on Windows XP . . . . . . . . . . . . . . . . . . 9

1.3.2 Unlocking String Studio on Mac OS . . . . . . . . . . . . . . . . . . . . . 12

1.3.3 Obtaining your response key and registering by fax or over the phone: . . . 17

1.4 Getting started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

1.4.1 Using MIDI Links . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

1.4.2 Using MIDI program changes . . . . . . . . . . . . . . . . . . . . . . . . 18

1.4.3 Using String Studio as a Plug-in . . . . . . . . . . . . . . . . . . . . . . . 19

1.5 Getting help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

1.6 Forum and User Library . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

1.7 About this manual . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

2 Browser and Presets 21

2.1 Playing Presets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

2.2 Editing and Saving Presets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

2.3 Deleting Presets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

2.4 Documenting Presets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

2.5 Defining a Default Preset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

2.6 Locating a Preset in the Browser . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

2.7 MIDI maps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

2.8 Exporting and Importing Presets and MIDI maps . . . . . . . . . . . . . . . . . . 23

2.9 Customizing the browser . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

3 Architecture of String Studio 25

3.1 General Signal Flow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

3.2 Modulation Sources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

3.3 Output Effect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28



4 CONTENTS

4 Parameters 29

4.1 General Functioning of the Interface . . . . . . . . . . . . . . . . . . . . . . . . . 29

4.1.1 Tweaking Knobs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

4.1.2 Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

4.1.3 Drop-down menus and Displays . . . . . . . . . . . . . . . . . . . . . . . 29

4.1.4 Inverting a Signal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

4.1.5 Bypassing a Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

4.1.6 Resetting a Module and Copying Settings . . . . . . . . . . . . . . . . . . 30

4.1.7 Modulation Signals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

4.2 The String Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

4.3 The Excitator Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

4.3.1 Plectrum . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

4.3.2 Hammer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

4.3.3 Bow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

4.4 The Body Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

4.5 The Damper Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

4.6 The Termination Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

4.7 The Geometry Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

4.8 The Pickup module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

4.9 The Distortion module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

4.10 The EQ module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

4.11 The Filter Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

4.11.1 Resonant Low-Pass Filter . . . . . . . . . . . . . . . . . . . . . . . . . . 40

4.11.2 Resonant High-Pass Filter . . . . . . . . . . . . . . . . . . . . . . . . . . 41

4.11.3 Band-Pass Filter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

4.11.4 Notch Filter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

4.11.5 Formant Filter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

4.12 The Filter Env Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

4.13 The LFO Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

4.13.1 Wave Shape . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

4.13.2 Rate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

4.13.3 Fade-In . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45



CONTENTS 5

4.14 The Keyboard Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

4.14.1 Tuning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

4.14.2 Mode and Priority . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

4.14.3 Unison . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

4.15 The Portamento Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

4.16 The Vibrato Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

4.17 The Arpeggiator Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

4.17.1 Arpeggio Patterns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

4.17.2 Rhythmic Patterns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

4.17.3 Rate and Synchronization . . . . . . . . . . . . . . . . . . . . . . . . . . 49

4.17.4 Latch mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

4.18 The Output Effect Section . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

4.18.1 The Clock Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

4.18.2 The Chorus Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

4.18.3 The Delay Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

4.18.4 The Reverb module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

4.18.5 Topology . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

4.18.6 The Output Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

4.18.7 The Recorder Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

5 Toolbar 53

5.1 Preset Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

5.2 MIDI map . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

5.3 Polyphony Combo Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

5.4 MIDI Channel combo box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

5.5 Value Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

5.6 CPU meter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

5.7 MIDI LED . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54



6 CONTENTS

6 Audio and MIDI Settings 55

6.1 Audio Device Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

6.2 MIDI Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

6.2.1 Selecting a MIDI Device . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

6.2.2 Creating MIDI Links . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

6.2.3 Editing MIDI Links . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

6.2.4 Deleting MIDI Links . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

6.2.5 Creating a MIDI Map . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

6.2.6 Creating the MIDI Program Change Map . . . . . . . . . . . . . . . . . . 57

6.3 Audio Control Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

6.4 Latency Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

7 Using the String Studio as a Plug-In 60

7.1 Window Size . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

7.2 Synchronization to the Host Sequencer . . . . . . . . . . . . . . . . . . . . . . . . 60

7.3 Audio and MIDI parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

7.4 Automation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

7.5 Multiple Instances . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

7.6 Saving Projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

7.7 MIDI channel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

7.8 MIDI program change . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

7.9 Performance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

8 Quick reference to commands and shortcuts 62

9 License Agreement 65



Introduction 7

1 Introduction

The String Studio is a synthesizer dedicated to the emulation of string instruments. The synthesizer
is entirely based on the A|A|S physical modeling technology and uses no sampling nor wave tables.
Instead it produces sound by solving, on the fly, mathematical equations modeling the different
components involved in string instruments and how they interact. This elaborate synthesis engine
responds dynamically to the control signals it receives while you play thereby reproducing the
richness and responsiveness of real string instruments.

String Studio features three types of excitators (hammer, pick, and bow) an accurate model
of a string, a model of the fret/finger interaction, a damper model and different types of sound-
boards. The combination of these different elements allows for the reproduction of a wide range
of string instruments. String Studio is also equipped with a distortion module, filters and a com-
prehensive output effect stage to add the finishing touch to the sound. Finally, String Studio offers
a wide range of performance features, including keyboard modes, portamento, vibrato and legato
functions, a programmable pattern arpeggiator, and a complete set of MIDI features for optimal
controller integration.

Before discussing the synthesizer in more detail, we would like to take this opportunity to thank
you for choosing an A|A|S product. We sincerely hope that this product will bring you inspiration,
pleasure and fulfill your creative needs.

1.1 System requirements

The following computer configuration is necessary to run the String Studio:

Mac OS :

• Mac OSX 10.2 (Jaguar) or later.

• G4 733 MHz Processor

• 256 MB RAM

• 1024 x 768 or higher screen resolution

• MIDI Keyboard (recommended)

• Ethernet Port

• Quicktime 4.0 or later

Windows :

• Windows 98SE/2000/XP

• PIII 800 MHz

• 128 MB RAM

• 1024 x 768 or higher screen resolution

• DirectX or ASIO supported sound card
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• MIDI Keyboard (recommended)

Keep in mind that the computational power required by the String Studio depends on the num-
ber of voices of polyphony and the sampling rate used. These computer configurations will enable
you to play the factory presets with a reasonable number of voices.

1.2 Installation

Mac OS

Insert the String Studio program disc into your CD-ROM drive. Open the CD icon once it
appears on your desktop. Click on the String Studio Install icon and follow the instructions of the
installer.

If you purchased this software online, simply double-click on the installer file that you have
downloaded and follow the instructions of the installer.

Windows

Insert the String Studio program disc into your CD-ROM drive. Launch Explorer to view the
content of the CD-ROM and double-click on the installer file to launch the installer.

If you purchased this software online, simply double-click on the installer file that you have
downloaded and follow the instructions of the installer.

1.3 Authorization and Registration

During the installation procedure, the authorization page will appear. The String Studio uses a
proprietary challenge/response copy protection system which requires you to provide some infor-
mation before using the program. You will need:

• A valid email address

• Your product serial number (on the back of the sleeve of your CD or in your confirmation
email for downloads)

A challenge key is a long string of capital letters and numbers that is generated uniquely for
each machine during the registration process. In other words, for each machine you install this
program on you will receive a different challenge key. The response key is another unique string of
capital letters and numbers generated from the data encrypted in the challenge key.
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1.3.1 Unlocking String Studio on Windows XP

Step 1: Generating the challenge key

After launching the installer for the first time, a pop-up window will appear asking you to enter
your serial number. Type your serial number as it appears on the back of the sleeve of the String
Studio CD-ROM. If you purchased String Studio online, an email with your serial number will
have been sent to you at the address which you provided during the purchase process.

Figure 1: Enter your serial number in the pop-up window.

After entering your serial number, click on the Next button and your challenge key will appear
automatically in the window.

Figure 2: Challenge key appears automatically after entering the serial number.
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Step 2: Generating the Response key and Registering your Product

If your computer is connected to the internet, the installer will automatically launch your web
browser and connect you to the unlock page of the A|A|S web server. Your serial number and
challenge key will automatically be printed in the form. Enter your email address and click on the
Submit button.

Figure 3: Enter your registration information on the A|A|S webserver.

The next form asks you to provide additional information about yourself including your mailing
address and phone number. This information will be used to register your product. Note that
only a valid email address is required to register your product. We nevertheless recommend this
information be provided to ensure our support team is able to contact you to resolve any future
support issues, and notify you of product updates promptly. This information is kept completely
confidential. Registration of your product will entitle you to receive support and download updates
when available, as well as take advantage of special upgrade prices offered from time to time
to registered A|A|S users. Note that this if you already purchased or registered another A|A|S
product, the information that you have already supplied under the same email address will appear
in the form. Feel free to update this information if it is outdated. Click on the Submit button and
your response key will appear on-screen.

If your computer is not connected to the internet, take note of your serial number and challenge
key and proceed to an internet connected computer. Launch your browser and go to the unlock
page of the A|A|S website at:

http://www.applied-acoustics.com/unlock.htm

Enter your email address, serial number, and challenge key, and click next. You will then
receive your response code on-screen as described above.
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Figure 4: Generation of the response key on the A|A|S server.

Step 3: Completing the unlock process

The response key corresponding to your serial number and challenge key will be printed in your
browser window. In order to complete the unlock process, copy the response key and paste it into
the last field of the installer window of String Studio. If you obtained your response key from
another computer, type the response key by hand in the installer window. Finally, click on the
Finish button in order to complete the unlock process.

Figure 5: Final step of the unlock process. Enter your response key in the window.

After unlocking String Studio, it will be launched. You will not need to re-unlock your software
unless:

• You reformat or upgrade your hard drive
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• You change or upgrade your operating system

• You uninstall the program

1.3.2 Unlocking String Studio on Mac OS

Generating the challenge key Automatically

After launching the installer for the first time, a pop-up window with information on the unlock
process will appear. Click on the right arrow to continue.

In the second window, shown in Figure 6, you will be offered to unlock String StudioAutomat-
ically orManually. If your computer is connected to the internet, choose Automatically and click
on the right arrow. If your computer is not connected to the internet, please follow the instructions
at the end of this section.

Figure 6: Choose the Automatic unlock mode if your computer is connected to the internet, other-
wise choose the manual method.

In the third window, shown in Figure 7, type your email address and click on the right arrow.
In the fourth window, see Figure 8, enter your serial number as it appears on the back of the sleeve
of the String Studio CD-ROM. If you purchased String Studio online, an email with your serial
number will have been sent to you at the address which you provided during the purchase process.
Click on the right arrow.

At this point, the installer will automatically launch your browser and connect you to the reg-
istration page of the A|A|S server as shown in Figure 9. You will be asked to provide additional
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Figure 7: Enter your email address.

Figure 8: Enter your serial number.

information about yourself including your mailing address and phone number. This information
will be used to register your product. Note that only a valid email address is required to regis-
ter your product. We nevertheless recommend this information be provided to ensure our support
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team is able to contact you to resolve any future support issues, and notify you of product updates
promptly. This information is kept completely confidential. Registration of your product will en-
title you to receive support and download updates when available, as well as take advantage of
special upgrade prices offered from time to time to registered A|A|S users. Note that this if you
already purchased or registered another A|A|S product, the information that you have already sup-
plied under the same email address will appear in the form. Feel free to update this information if
it is outdated. Click on the Next button and your challenge key will appear in the window as shown
in Figure 10. Copy the response key and paste it in the String Studio installer window as illustrated
in Figure 11. Click on the Start button to complete the unlock process.

Figure 9: Enter your registration information on the A|A|S webserver.

Figure 10: Generation of the response key on the A|A|S server.



1.3 Authorization and Registration 15

Figure 11: Final step of the unlock process. Enter your response key in the window.

Generating the challenge key Manually

If your computer is not connected to the internet, choose Manually in the second page displayed
by the installer, as shown in Figure 12, and click on the right arrow.

In the third window, the same as in Figure 7, type your email address and click on the right
arrow. In the fourth window, please refer to Figure 8, enter your serial number as it appears on the
back of the sleeve of the String Studio CD-ROM. If you purchased String Studio online, an email
with your serial number will have been sent to you at the address which you provided during the
purchase process. Click on the right arrow and your challenge key will be displayed as illustrated
in Figure 13. For convenience, click on the Save Registration Information... button to save this
information in a text file.

Take note of your serial number and challenge key and proceed to an internet connected com-
puter. Launch your browser and go to the unlock page of the A|A|S website at:

http://www.applied-acoustics.com/unlock.htm

Enter your email address, serial number, and challenge key, and click next. You will then
receive your response code on-screen as shown in Figures 9 and 10.

In order to complete the unlock process, go back to the sixth String Studio installer window
and type your response key as shown in Figure 11. Finally, click on the arrow button and on then
on the Start button in order to unlock your synthesizer.

Once the unlock process will have been completed, String Studio will be launched. You will
not need to re-unlock your software unless:
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Figure 12: Choose the manual unlock mode if your computer is not connected to the internet.

Figure 13: Generation of the challenge key during manual installation.

• You change your computer

• You uninstall the program
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1.3.3 Obtaining your response key and registering by fax or over the phone:

Should you not have access to the internet, A|A|S support representatives are available to assist
you in the unlock and registration process Monday to Friday, 9am to 6pm EST. You may contact
us by phone at:

• North America Toll-free number: 1-888-441-8277

• Outside North America: 1-514-871-8100

• Fax Number: 1-514-845-1875

• Email: support@applied-acoustics.com

1.4 Getting started

The String Studio comes with a wide range of factory presets right out of the box which amounts to
a huge range of sounds before you have even turned a single knob. As you would expect, the best
way of coming to grips with the possibilities String Studio offers is simply to go through the presets
one at a time. We recommend that you first start using the String Studio in standalone mode.

Using String Studio in standalone mode

• Windows - Double-click on the String Studio icon located on your desktop or select String
Studio from the Start > All Programs > menu.

• Mac OS - Double-click on the String Studio icon located in the Applications folder.

Before you start exploring the factory presets, take a moment to set up you audio and MIDI
configuration as explained below.

Audio Configuration

This menu allows you to select a port from a list, organized by driver type, of those available
on your computer. If you have ASIO drivers available, these should be selected for optimum
performance. Multi-channel interfaces will have their outputs listed as stereo pairs.

• Windows - Select your sound card port from the list in the Audio Configuration dialog
from the Edit > Preferences > Audio Settings . . . menu.

• MacOS - Select your audio device from the list in theAudio Settings dialog from the String
Studio > Preferences > Audio Settings . . . menu.

For more detailed information on audio configuration, sampling rate selection and latency ad-
justments, please refer to section 6.4.
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MIDI Configuration

• Windows - Select your MIDI port from the list in theMIDI Configuration dialog from the
Edit > Preferences >MIDI Settings . . . menu.

• Mac OS - Select your MIDI port from the list in the MIDI Settings dialog from the String
Studio > Preferences > . . . menu.

For more detailed information on MIDI configuration, MIDI links and MIDI maps, please refer
to section 6.2.

Exploring the factory presets

The browser on the left of the String Studio interface is similar to the browser your operating system
generates to display the contents of your hard disk, or your email program uses to organize your
mail and address book. When launching the application for the first time, this “tree view” will
include a destination folder for imported presets as well as different folders containing different
categories of factory presets. To open a folder, click on the “+” symbol which will reveal the
folder content. To load a preset, double-click on a preset icon (blue knob).

The Browser makes it easy to organize presets in whatever manner you choose. To create a
new preset folder, click in the browser to select this region of the interface, and chooseNew Folder
from the File menu. You can now save new presets in this folder or copy or move existing presets
to this folder by dragging preset icons from one folder to the other or using the Copy and Paste
commands from the Edit menu.

1.4.1 Using MIDI Links

Every parameter on the String Studio interface can be linked to an external MIDI controller. To
assign a MIDI Link, right-click (control-click on Mac) on a control (knob, button or slider) and a
contextual menu will appear. Select Learn MIDILink and move a knob or slider on your MIDI
controller to activate the link. To deactivate the link, right-click (control-click on Mac) on the
control and choose the Forget MIDILink command.

1.4.2 Using MIDI program changes

MIDI program changes have been assigned to a selection of factory presets. The factory library
can therefore be explored using MIDI program changes.
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1.4.3 Using String Studio as a Plug-in

The String Studio integrates seamlessly into the industry most popular multi-track recording and
sequencing environments as a virtual instrument plug-in. The String Studio works as any other
plug-in in these environments so we recommend that you refer to your sequencer documentation
in case you have problems running the String Studio as a plug-in.

1.5 Getting help

A|A|S technical support representatives are on hand from Monday to Friday, 9am to 6pm EST.
Whether you have a question on String Studio, or need a hand getting it up and running as a plug-in
in your favorite sequencer, we are here to help. Contact us by phone, fax, or email at:

• North America Toll Free: 1-888-441-8277

• Worldwide: 1-514-871-8100

• Fax: 1-514-845-1875

• Email: support@applied-acoustics.com

Our online support pages contain downloads of the most recent product updates, and answers
to frequently asked questions on all A|A|S products. The support pages are located at:

www.applied-acoustics.com/faq.htm

1.6 Forum and User Library

The A|A|S community site contains the String Studio user forum, a place to meet other users and
get answers to your questions. The community site also contains an exchange area where you will
find presets for your A|A|S products created by other users and where you can make your own
creations available to other users.

http://community.applied-acoustics.com/php/community

http://community.applied-acoustics.com/php/forum

1.7 About this manual

In the next chapter, the use of presets and the browser are described in detail. Chapter 3 describes
the general architecture and signal flow of String Studio. In Chapter 4, the different modules and
controls are reviewed in detail. Chapter 5 describes the different functionalities available from the
toolbar while Chapter 6 explains the different functionalities related to Audio and MIDI and their
settings. General issues involved in the use of String Studio as a plug-in in different host sequencers
is covered in Chapter 7. Finally a list of available commands and shortcuts is given in Chapter 8.

Throughout this manual, the following conventions are used:
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• Bold characters are used to name modules, commands and menu names.

• Italic characters are used to name controls on the interface.

• Windows and Mac OS keyboard shortcuts are written as Windows shortcut/Mac OS shortcut.
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2 Browser and Presets

String Studio comes with several factory presets covering a wide range
of sounds. This collection of presets lets you play and familiarize your-
self with this synthesizer without having to tweak a single knob. Soon,
however, you will be experimenting and creating your own sounds that
you will need to archive or exchange with other users. All the operations
on presets are conveniently managed with the help of the String Studio
Browser, similar to those found in most email programs, which uses a hi-
erarchical tree structure and a visually intuitive, drag and drop approach.

2.1 Playing Presets

All the presets are located in the String Studio root folder. To explore
the different presets available in String Studio, click on the “+” icon to
the left of the String Studio folder, in other words, expand this branch
of the browser tree, in order to reveal the various preset sub-folders based
on different sound categories. Opening the individual sub-folders reveals
a set of presets represented by blue knob icons.

• To load a preset, simply double-click on the preset icon or drag and drop the preset icon from
the browser onto the synthesizer interface.

• Switch to the next or previous preset in the hierarchy by clicking on the “+” and “-” sign on
the right of the preset name in the left corner of the toolbar at the top of the String Studio
interface, or by using the “+” and “-” keys of the computer keyboard.

• Select a preset in the Browser by using the up and down arrows from the computer keyboard
and click on the Enter key of the keyboard.

• You can also load a preset by right-clicking/control-clicking on a preset icon and choosing
theOpen Preset command from the drop-down menu that appears, or by clicking on a preset
icon in order to select it, then using the Ctrl-O/Apple-O shortcut.

• It is also possible to load presets using MIDI program changes as described in Section 6.2.

• Switch to the next or previous preset in the hierarchy by clicking on the “+” and “-” sign on
the right of the preset name in the left corner of the toolbar at the top of the String Studio
interface, or by using the “+” and “-” keys of the computer keyboard.

2.2 Editing and Saving Presets

As soon as a preset is modified, the preset icon located just before the preset name in the toolbar
changes color, indicating that you must save the preset in order not to lose the changes. Modifi-
cations to an existing preset are saved using the Save Preset command from the File menu or the
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Ctrl-S/Apple-S shortcut. Be careful, however, as using this command will overwrite the original
preset. In order to create a new preset, use the Save Preset As command from the File menu and
a window will appear asking for a name for the new preset. Once the preset is saved using this
command, a new preset icon will appear directly under the String Studio folder.

Note that after having modified a preset, String Studio will always ask you if you want to save
the changes in order not to lose your work. However, this behavior is however not always conve-
nient. To disable this option, select the General command under Preferences of the Edit menu
and de-select the Ask to save preset before opening another option. By default, String Studio
will also ask you if you want to save changes to a modified preset before quitting the application.
To disable this option, de-select the Ask to save preset before quitting option under the same
command as mentioned above.

When editing presets and creating new ones, it is very helpful to go back and forth between the
different stages of your modifications and adjustments. To move back step by step through every
modification that was applied to a preset, use the Undo command from the Edit menu or the Ctrl-
Z/Apple-Z shortcut. Once the Undo command has been used, it is also possible to move up again
through the modifications by using the Redo command from the Editmenu or the Ctrl-Y/Apple-Y
command. Note that the number of Undo levels is unlimited and that this command is effective on
any control of the interface but not on the different Save commands.

Once a preset has been modified, it is also possible to move back and forth between the current
state of the preset and its original state when it was loaded. This is very helpful in order to hear
again the original preset after having applied many modifications. To hear the original preset,
simply click on the Compare button of the toolbar or the Compare command from the Edit menu.
Once this button has been pressed, the original settings of the preset are loaded. Note that in this
mode, the graphical interface is frozen and it is therefore not possible to modify the preset. To
further modify the preset, click on the Compare button again or uncheck the Compare command
in the Edit menu to revert to the modified version of the preset and unfreeze the interface.

2.3 Deleting Presets

To delete a preset, first select it by clicking on its icon in the browser, then use the Delete command
from the Edit menu or the Del key from the computer keyboard.

2.4 Documenting Presets

It is possible to document a preset or view related information from the Edit Preset Information
window. To launch this window, right-click/control-click on a preset icon and choose the Preset
Info command or use the Ctrl-I/Apple-I shortcut. The Preset Info command from the Edit menu
can also be used after selecting a preset. Information on a preset includes the author’s name,
copyright notice, date of creation, last modification date and a text description.
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2.5 Defining a Default Preset

It is possible to define a default preset that will be loaded automatically when String Studio is
launched. To define a default preset, select a preset by clicking on its icon in the browser. Then
launch the Edit Preset Informationwindow as explained in the preceding paragraph and select the
Mark As Default option. To change the default preset, just repeat the operation on a new preset. If
no default preset has been defined, the default values for every module will be loaded when String
Studio is launched.

2.6 Locating a Preset in the Browser

After navigating through presets, it might be difficult to find the current preset icon in the browser.
To rapidly locate the current preset in the browser, use the Locate command from theViewmenu or
the Ctrl-L/Apple-L shortcut. The Locate command will automatically expand the folder containing
the currently used preset and select the preset.

2.7 MIDI maps

MIDI maps containing information about MIDI links between the MIDI controllers and the String
Studio interface can easily be created as will be explained in Section 6.2. MIDI maps are rep-
resented in the browser with a MIDI connector icon. MIDI maps are treated exactly the same
way as presets in the browser and are saved using the Save MIDI Links or Save MIDI Links As
commands from the File menu.

2.8 Exporting and Importing Presets and MIDI maps

The Import and Export commands, found in the File drop down menu, allow one to easily ex-
change presets and MIDI maps with other String Studio users. This feature can also be used to
decrease the number of elements in the browser by archiving older or rarely used ones elsewhere,
on CD-R, or a second hard disk for example. Files containing String Studio presets and MIDI maps
are equivalent in size to short text file, making it easy to send presets to other users via email.

To export a folder, a group of folders, presets or MIDI maps within a folder, select the elements
to export in the browser and use the Export command from the File menu. When the Export
window appears, choose a file name and a destination location on your hard disk. String Studio
export files will be saved with an “sxf” extension.

Importing presets and MIDI maps is just as easy. Simply click on the Import command from
the File drop down menu, and select the file to import. A new folder will then appear under the
Imports directory in the browser, containing all of the files contained within the imported package.
These can then be dragged and dropped to a new folder, or remain in the Imports directory.
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2.9 Customizing the browser

The Browser structure can be customized in various ways. New folders can be created from the
File drop down menu using the Create New Folder command. One can also move presets, MIDI
maps, and folders from one place in the browser to another by using theCopy and Paste commands
from the Edit drop down menu, or by simply dragging objects from one folder and dropping them
into the folder of your choice. Ultimately, how things are organized is left entirely up to you.

The browser can also be hidden from the interface. This can be convenient in order to save
screen space. To hide the browser, use theHide Browser command from the Viewmenu. To make
it reappear, use the Show Browser command from the View menu.
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3 Architecture of String Studio

String Studio is a synthesizer built around a Stringmodule. The graphical interface of the different
modules of the synthesizer have been grouped into two panels as shown in Figures 14 and 15. In
the first page (Panel A), one can find the modules related to the control of the synthesizer and an
output effect stage. The actual synthesis modules appear on the second page (Panel B). One can
switch from one view to the other by using the Panel A and Panel B buttons appearing at the top of
the interface.

Figure 14: Control modules and output stage of String Studio (Panel A).

The first row of modules of Panel A is an output effect stage which includes a multi-effect
module, a master clock module, a master level control, and a recorder module. The bottom row
of this same panel includes the modules related to performance and the processing of MIDI events
including a Keyboard, Arpeggiator, Portamento and Vibrato module.

The modules of Panel B follow the general geometry of a string instrument which and is
composed of 5 main components: the String, the Excitator, the Body, the Termination and the
Damper module.

The individual modules and controls of the user interface will be described in detail in Chap-
ter 4. We will now take a closer look “under the hood” at how the different modules are connected
together.
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Figure 15: Synthesis modules of String Studio (Panel B).

3.1 General Signal Flow

The general architecture of String Studio is presented in Figure 16 and follows the functioning of a
real string instrument.

It is the vibration from the String which constitutes the main sound production mechanism of
the instrument. The string is set into motion by the action of an Excitator which can be a hammer,
a pick or a bow. The frequency of the oscillation is determined by the effective length of the string
which is controlled by the finger/fret interaction or Termination. A Damper can be applied on
the strings in order to reduce the decay time of the oscillation. This is the case on a piano, for
example, when felt is applied on the strings when the keys and the sustain pedal are released.
The vibration from the string is then transmitted to the Body of the instrument which can radiate
sound efficiently. In some instruments, the string vibration is transmitted directly to the through
the bridge. In other instruments, such as the electric guitar, a Pickup is used to transmit the string
vibration to an amplifier.

In addition to these main modules, a Filter module has been included between the String and
Body module in order to expand the sonic possibilities of the instrument. A Distortion module,
an EQ module, and an output effect stage complete the synthesizer as illustrated in the signal flow
diagram of Figure 17.
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Figure 16: General representation of String Studio.
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Figure 17: Signal flow of String Studio. Modulation signals: dotted lines.

3.2 Modulation Sources

The physical parameters of the String, Excitator, Damper, and Termination modules can be
modulated with the pitch and velocity signals received from theKeyboard. In addition to the pitch
signal from the Keyboard, the cutoff frequency and resonance (quality factor) of the multi-mode
Filter module can be modulated with the signal from a low-frequency oscillator LFO module and
the Filter Env envelope generator. Finally, note that the vibrato module from Panel A can be
considered as an extra pitch modulation source for the String module.
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3.3 Output Effect

At the end of the signal path, the audio signal from the instrument is sent to the output effect stage
for further processing. A Reverb, Delay, and Chorus module are available in this effect stage
allowing for a wide range of processing possibilities. Effects can be applied before or after mixing
of the signal from each line as will be explained in greater detail in Section 4.18.
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4 Parameters

4.1 General Functioning of the Interface

4.1.1 Tweaking Knobs

All the knobs on the interface are selected by clicking on them. Once selected, they can be con-
trolled in different ways depending on the effect you want to achieve.

• For coarse adjustment click-hold on a knob and drag the mouse upwards or downwards to
move it clockwise or counter-clockwise.

• For fine adjustment, use the left or down arrow of the computer keyboard to move the knob
counterclockwise and the right or up arrow to move it clockwise. The Page Up and Page
Down keys give the same result with slightly faster action.

• To move a control to a given position, place the mouse at this position and Shift-click (Win-
dows) or Option-click (Mac OS). To reach this position slowly, do the same, but use the
middle button of the mouse (Windows only).

• Knobs with a green LED above can be moved directly to their center position by clicking on
the LED.

Remember that the keyboard shortcuts affect only the most recently selected control. The value
of the control currently selected is displayed on the toolbar at the top of the String Studio window.
The number displayed on the counter is a value corresponding to the setting of the control currently
selected. For knobs, the reading is a value between 0 (turned fully to the left) and 127 (turned fully
to the right).

4.1.2 Buttons

Buttons are switched on or off by clicking on them. The value appearing in toolbar and corre-
sponding to a button is 1 when the button is on and 0 when it is off.

4.1.3 Drop-down menus and Displays

Clicking on a display with a small down-pointing triangle on its right, such as the Type control of
the Excitator module, reveals a drop-down menu with a set of possible settings for the control.
Adjustment of the control is obtained by clicking on a selection or using the up and down arrows
and the Enter key of the computer keyboard.

The other controls represented by a display without a down-pointing arrow, such as the Tempo
control of theClockmodule, are adjusted by click-holding on them and dragging the mouse upward
or downward. Selection of these controls is possible when the mouse is positioned on the display
and a double pointing arrow appears.
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4.1.4 Inverting a Signal

The different modulation signals acting on the String, Excitator, Body, Termination, and Filter
modules can easily be inverted by clicking on the small button appearing on the upper right of the
corresponding gain knob. The signal is inverted when the button is on (LED lit on and value of 1).

4.1.5 Bypassing a Module

The different modules of String Studio can be turned on or off by clicking on the button appearing
on the right of the module label. A module is active when the button is in its on position or in other
words when it is lit and has a value of 1. Note that when a module is not activated, calculations
associated with this module are not performed, reducing CPU usage.

4.1.6 Resetting a Module and Copying Settings

The modules of String Studio can be reset to their default value by clicking on the down pointing
triangle appearing on the left of the module label and selecting the Default Settings command.

4.1.7 Modulation Signals

Different parameters can be modulated with signals from the Keyboard, LFO or Filter Env
modules. Modulation signals are controlled with gray knobs located below the black knobs corre-
sponding to the modulated parameter. These knobs are in fact gain knobs that are used to multiply
the modulation signal by a certain factor. When these knobs are in their leftmost position, the mod-
ulation signals are multiplied by zero which has the effect of turning off the modulation source.
Turning the knobs clockwise increases the gain factor and therefore the influence of the correspond-
ing modulation source. The modulation signal can be inverted by clicking on the LED located on
the right at just above the knob.

Each modulation knob can control multiple modulation signals. The source of the modulation
signal is selected by clicking on one of the green LEDs located on the right of the line of gray
knobs. The sources are labeled Kbd (Keyboard), LFO, and Env (Filter Env). Each time a new
source is selected, the knobs revert to the setting corresponding to this source.

The Kbd modulation signal is used to vary the value of a parameter as a function of the pitch of
the note played. When the modulation source is turned off (knob in its leftmost position), the value
of the parameter is constant over the whole range of the keyboard and equal to the value determined
by the corresponding parameter knob. Turning the modulation knob clockwise will increase the
value of the parameter in the high frequencies while lowering its value for the low notes. This
modulation is applied relative to the middle C (C3) which always keeps the value fixed by the
parameter knob. For example, choosing a hammer as an excitator, and modulating its stiffness with
the pitch signal from the keyboard (Kbd) will make the hammer stiffer for high notes and softer for
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low notes which is a feature found in many keyboard instruments. Clicking on the inverter LED at
the top of the modulation knob inverts this behavior.

4.2 The String Module

In a string instrument most of the sound we hear is radiated from
the body of the instrument. The strings themselves radiate just a small
amount of sound directly but it is their vibrations that are transmitted to
the body of the instrument, through the bridge, where they can be radiated
efficiently. It is also the strings that fix the pitch of the sound we hear
depending on their effective lengths.

In a real string, the material of the string will affect how it vibrates.
For example, a metal string will oscillate for a longer time than a nylon one; its sound will also be
brighter. In the String module, this behavior is adjusted with the Damping and Decay knobs. The
Damping knob is used to set the amount of high frequencies in the string vibration, this amount
being increased as the knob is turned clockwise. The decay time of the vibrations is controlled
with the help of the Decay knob and it is increased by turning the knob clockwise. Both of these
parameters can be modulated with the pitch signal received from the keyboard.

In a first approximation, a string can be considered to be harmonic meaning that its partials are
located at frequencies equal to multiples of its fundamental frequencies. Real strings, however, are
more or less inharmonic depending mostly on the width of the string. This characteristic of strings
is adjusted with the Inharm knob. When the Inharm knob is in its leftmost position, the string will
be perfectly harmonic and turning the knob clockwise will increasingly detune the partials toward
higher frequencies.

When the Ratio LED is on (LED lit and value of 1), the gray knob located below the Decay
knob is used to adjust the ratio between the decay time of the oscillation of the string when the a
note is depressed and when it is released. When the knob is in its leftmost position, both decay
times are the same and equal to the decay time determined by the settings of the Decay knob.
Turning this knob clockwise will decrease the decay time of the note when it is released while
keeping the decay time when the key is depressed to its current setting. Note that this control
constitutes an easy mean to reproduce the action of dampers on the string. When the Damper
module is used and the Rto knob is turned clockwise, the effect of the both damping mechanisms
will add up.
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4.3 The Excitator Module

The String module can be played using different types of exci-
tators in order to reproduce different types of instruments and play-
ing techniques. The excitator is selected using the Type drop-down
menu. The choices available are Plectrum, Hammer 1, Hammer2 or
Bow. These different types of excitators share the same front panel
but note that the names of the parameters controlled by the differ-
ent black knobs vary for each excitator. Next we will review the
different types in more detail.

4.3.1 Plectrum

The Plectrum excitator, illustrated in Figure 18, is used to play in-
struments such as guitars, harpsichords or basses with a pick. The Plectrum can be viewed as
an angled object placed under the string and connected to a plate with the help of a spring. The
purpose of the plectrum is to impose an initial displacement to the string before it is set into free
vibration. As can be understood from figure 18, a vertical motion of the plate (which could be
a hand holding the plectrum) will lift the string with the plectrum but will also result in a com-
pression of the spring and an horizontal motion of the plectrum. The string will move with the
plectrum until the protrusion Prot of the plectrum is equal to the compression of the spring and the
string is released. The motion and behavior of the plectrum is controlled by adjusting the different
geometrical and mechanical properties of the system.

The Prot knob is used to determine the protrusion of the plectrum with respect to the string
while the stiffness and damping of the spring is controlled with the help of the Stiff and Damp
knobs. The vertical velocity of the plectrum is adjusted with the Velocity knob. Note that the Prot,
Stiff, and Velocity controls can be modulated with the pitch of the note played or the velocity signal
from the keyboard.

String

Plectrum
Damping

Stiffness

Velocity

Prot

Figure 18: Functioning of the Plectrum
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4.3.2 Hammer

The Hammer is used to play instruments such as the piano or other percussive instruments. With
this excitator, the string is set into free vibration following a force impact with the hammer. The
hammer can be used in two modes, Hammer and Hammer 2, as illustrated in Figure 19. In the
Hammer 1 mode, the hammer is located below the string and can only interact once with the string
because of the action of gravity which brings it down after it has been raised to hit the string. In
the Hammer 2 mode, the hammer is located above the string and can bounce on the string after the
initial impact.

The illustration of 19 shows that the action of the hammer is represented by the motion of a
head connected to a mass. The mass of the hammer is adjusted with the Mass knob while the
stiffness of the head is controlled with the Stiff knob. The velocity of the hammer when it hits the
string is set with the velocity knob. The motion of the hammer can further be characterized by a
damping coefficient, adjusted with the Damp knob, and controlling the absorption of the impact
between the string and the hammer by the hammer. Note that this parameter is not related to the
decay time of the string oscillation or the overall sound. On the contrary, the effect of this parameter
may sometimes seem counter-intuitive even if it reproduces a physical property of the hammer. For
example, increasing the damping of the hammer will make the compression of the spring linking
the head to the mass harder and which will shorten the interaction between the hammer and the
string but will also make it appear stronger resulting in a louder or longer sound.

Damping

Mass

Stiffness

String

Velocity

Damping
Velocity

Mass

Stiffness

String

Hammer 1 Hammer 2

Figure 19: The two Hammer modes

4.3.3 Bow

The Bow excitator is used to play bowed instruments such as the violin, viola, or cello. The role
of the bow is to set the string in self-sustained oscillation. Physically, oscillations of the string are
maintained by a regular cycle of stick-slip-stick-slip movements. Due to friction forces between
the string and the bow, the string sticks to the bow and follows its motion until the tension forces
in the string, due to its own oscillating motion, break it free from the bow. The string is then in its
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slip phase and moves in the opposite direction to that of the bow. When the string motion changes
direction once more, it sticks to the bow again, moving with the bow until it breaks free and repeats
the cycle. Note that the frequency of this stick-slip motion is exactly the same as that of the string
oscillation; or, in other words, the pitch of the note played.

The force with which the bow is applied on the string can be adjusted with the Force knob, the
friction between the bow and the string is set with the Friction knob, and the velocity of the bow
is controlled with the Velocity knob. Note that the damp knob is inactive when the bow excitator is
selected. The tone and behavior of the instrument are the results of a complex relationship between
these parameters but some general rules can however be followed. As the force applied by the bow
on the string is increased, the tone becomes more scrubby. The friction between the bow and the
string usually determines the length of the attack; the greater the friction, the faster the string can
be set into motion. Finally, the velocity is related to the amplitude of the sound.

Force

Velocity
String

Bow

Figure 20: Excitation of a string by a bow

4.4 The Body Module

The role of the body or soundboard of a string instrument is
to radiate the vibration energy from the strings. The body also
adds a filtering effect to the vibration from the string which de-
pends on its size and shape. In some instruments such as guitars,
the body also includes an air cavity which boosts low frequen-
cies.

The Type drop-down menu allows one to choose between dif-
ferent body geometries, each of them reproducing the spectral
characteristics of the body of different type of instruments. For
each type of body one can also determine its size with the help
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of the Size drop-down menu from Tiny to Huge. Basically, reducing the size of the Body, shifts its
frequency response toward higher frequencies while increasing it, results in a shift toward lower
frequencies. In addition to its shape and size, the material of the body also influences its radiation
and filtering effects. This behavior is adjusted with the Damp and Decay knobs. The Damp knob
is used to set the amount of high frequencies in the body vibration, this amount being increased as
the knob is turned clockwise. The decay time of the vibrations is controlled with the help of the
Decay knob; it is increased by turning the knob clockwise.

The output signal from the Body module can further be monitored with the Mix and Level
knobs. The Mix knob is used to adjust the ratio of direct signal from the String module and the
signal filtered by the Body in the output signal of the Body module. In its leftmost position the
output signal from the Bodymodule will be that from the Stringmodule only while in its rightmost
position, there is no direct signal from the String module. When this knob is in its center position,
there is equal amounts of direct and filtered signal in the output signal of the Bodymodule. Finally,
the general level of the output signal from the Bodymodule is controlled with the Level knob. Note
that the level of the output signal can be monitored with the Signal LED. This can be helpful when
trying to adjust the signal level at the input of the Distortion module or the other effect modules.
The color of the LED gives a rough indication of the sound level, when it is green the signal from
the body is faint, when it is orange the level is in the middle range while when it is red, the signal
level is high.

Note that the Bodymodule is made inactive or bypassed by selecting the Off option in the Type
control. Even when this option is chosen, the Level knob is active which means that the sound level
from the String can still be monitored by this knob.

4.5 The Damper Module

TheDampermodule is used to attenuate rapidly the vibration
of the string. In a piano or harpsichord, this role is played by
felts while for the violin or the guitar, the performer’s finger is
used to damp the string vibrations. Basically, the damper can be
viewed as a mass/spring system acting on the string as illustrated
in Figure 21. The Mass and Stiff knobs are used to adjust these
parameters, which affect how the damper interacts with the string.
These physical parameters can be modulated with the pitch signal
from the Keyboard and fine-tuned over the whole range of the
instrument. The Velocity knob is used to adjust the velocity at which the damper is applied and
released from the string. This parameter can also be modulated with the pitch signal from the
Keyboard module. The last parameter of the Damper module is controlled with the Damp knob
and refers to the ability of the damper to absorb energy from the string. Turning this knob clockwise
will increase the damping exerted on the string by the damper.
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Figure 21: Functioning of the Damper

4.6 The Termination Module

This module is used to model the fret/finger/string interac-
tion as illustrated in Figure 22. In a real instrument, this inter-
action is used to change the effective length of the string and
thereby fix the pitch of the note played. The physical parame-
ters of the Finger can be varied with both the Stiff and Force
knobs which fix respectively the stiffness of the termination and
the force it applies on the string. Note that the Force parameter
can be modulated by both the pitch and velocity signal from the
Keyboard module. The termination can further be character-
ized by the stiffness of the fret on which the string, pushed by the finger, is applied. This parameter
is controlled by the Stiff knob under the Fret label.

Stiffness

Stiffness

Mass

Fret

String

Finger

Figure 22: The finger/fret interaction
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4.7 The Geometry Module

The Geometry module is used to set the location of the point
of action of both the excitator and the damper on the string. These
positions are adjusted with the Position knobs under the Excitator and
Damper labels and can be set to any value between zero (the point of
fixation of the string) and half the length of the string (value of 0.5).

When the Abs (absolute position) LED is switched on, the posi-
tion of the excitator or the damper is fixed whatever the note played.
This would be the case, for example, on a guitar when the player keeps the position of the pick
fixed while varying the effective length of the string when changing notes. The actual position is
determined with the setting of the Position knob applied to the length of a string corresponding to
C3 (middle C). Note that when the note played is such that the string length corresponding to this
note is shorter than this position, the excitator or the damper will follow the fixation point of the
string.

When the Abs LED is in its off position, the location of the damper or the excitator is changed
in order to always correspond to a certain fraction of the length of the string. This fraction of the
string length is that determined by the Position knob. This type of geometry is found in instruments
such as the piano where hammers excite strings at about 1/7 of their length.

Note that both the excitator and damper position can be modulated with the pitch signal or
velocity signal received from the keyboard. The modulation will be relative to the value set by the
excitator or damper Position knobs.

4.8 The Pickup module

The Pickupmodule reproduces the functioning of magnetic pick-
ups such as found in electric guitars or electric pianos. This type
of transducer is sensitive to the motion of a nearby metallic string.
When a string vibrates near a pickup, the latter outputs an oscillating
signal at the same frequency as that of the string and proportional to
the string velocity.

The only parameter to adjust in the Pickup module is its position relative to the string which
affects the waveform of its output.

Note that usually, the signal from a pickup is sent directly to an external device such as an
amplifier. In other words, the body of the instrument does not play any role in the radiation of
the sound. In String Studio, this behavior is obtained when the Pickup module is on and both the
Filter and Bodymodules are switched off. When the Pickup, the Filter and Bodymodules are on,
the output signal from the Pickup is filtered by the Filter and Body modules. Finally, when the
Pickup module is switched off, the output signal from the String is sent directly to the Filter and
Body module.
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4.9 The Distortion module

TheDistortionmodule implements a simple distortion effect, such
as that found in electric guitar distortion pedals for example. Different
distortion algorithms, ranging from mellow to metal, can be selected
from the Type drop-down menu.

The Drive knob is a gain control used to adjust the level of the
signal at the input of the Distortion module and hence the amount of
saturation introduced in the signal. The color of the signal after the distortion algorithm has been
applied can be adjusted using the Tone knob. In its leftmost position, high frequencies will be
attenuated in the signal while in its rightmost position low frequencies will be filtered out from the
signal. In its center position, the signal will be left unchanged. Note that this control can be set to
its middle position by clicking on the small LED above the knob. Finally, the Level knob is used to
control the amplitude of the signal at the output of the Distortion module.

4.10 The EQ module

TheEQmodule provides equalization over the low, mid, and high
frequency bands. This module is located after the Distortion module
in the signal chain and is composed of a low shelf filter, a bandpass
filter, and a high shelf filter in series.

The functioning of the low shelf filter is illustrated in Figure 23.
The filter applies a gain factor to frequency components located be-
low a cutoff frequency while leaving those above unchanged. The
cutoff frequency of the filter is adjusted using the Freq knob and the
gain amount is controlled with the Gain knob.

The high frequency content of the signal is controlled with a high shelf filter that works in
the opposite manner as the low shelf filter as illustrated in Figure 23. The filter will multiply a
gain factor to components located above a cutoff frequency while leaving those below unchanged.
Again use the Freq and Gain knobs to adjust the cutoff frequency and gain of the filter.

The mid frequency content of the signal is adjusted using a peak filter as illustrated in Fig-
ure 24. The filter applies a gain factor to frequency components in a band located around the cutoff
frequency of the filter. The cutoff frequency of the filter is adjusted with the Freq knob while the
gain coefficient is varied with the Gain knob. In addition to these parameters, the width of the
frequency band can be adjusted with the Q knob.
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Figure 23: Low and high shelf filters.
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Figure 24: Peak filter.

4.11 The Filter Module

In order to expand the sonic possibilities of String Stu-
dio, a multi-mode filter has been inserted between the String
and Body modules. This multi-mode filter includes a res-
onant low-pass, band-pass, high-pass, notch and a formant
filter which can be selected using the Type drop-down menu.
The order of the filter can be adjusted to 2 (-12 dB/oct for
low-pass and high-pass and -6 db/oct for band-pass) or 4
(-24 dB/oct for low-pass and high-pass and -12 db/oct for
band-pass) with the help of the Order drop-down menu.
The resonance frequency of the filter is adjusted with the
Cutoff knob while its Q-factor or resonance is controlled
with the Q knob. When the formant filter is used, the Q knob is used to cycle between the vowels
(a, e, i, o, u).
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The cutoff frequency and resonance of the filters can be modulated with different modulation
sources. The modulation sources include the keyboard pitch signal (Kbd) and the output of the
Filter Envenvelope generator (Env) and LFO modules. Modulation signals with a positive value
will increase the cutoff frequency and Q-factor of the filters while a negative value will decrease
them. Note that the filter parameters can further be modulated by the velocity signal from the
keyboard through the use of the velocity modulation parameter of the Filter Env modules.

The modulation knob associated with the cutoff frequency can be adjusted to its center position
by clicking on the green LED located above the knob. In this position, the cutoff frequency will
exactly follow the pitch of the note played on the keyboard in the case of the Kbd modulation, it
will vary exactly one octave higher and lower in the case of the LFO modulation and will vary one
octave higher or lower depending on the position of the inv switch with the Env modulation. Now
let’s have a closer look at the different filter types available.

4.11.1 Resonant Low-Pass Filter
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Frequency
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Figure 25: Frequency response of the low-pass filter.

A low-pass filter is used to remove the higher spectral components of the signal while leaving
the lower components unchanged. The frequency at which attenuation begins to take effect is
called the cutoff frequency. In a resonant filter, frequencies located around the cutoff frequency
can also be emphasized by an amount called the quality factor or Q-factor of the filter as illustrated
in Figure 25. The higher the Q-factor, the louder and sharper the response of the filter around
the cut-off frequency. When the Q-factor is set to 1 (Q knob fully turned to the left), there is no
emphasis around the cutoff frequency and the attenuation is -3dB at the cutoff frequency. The
attenuation for frequencies located above the cut-off frequency depends on the order of the filter
which is determined by the Order menu, a slope of -12dB/Oct corresponding to a second order
filter and a slope of -24dB/Oct to a fourth order filter.
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4.11.2 Resonant High-Pass Filter
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Figure 26: Frequency response of the high-pass filter.

The high-pass resonant filter works in exactly the opposite manner as the low-pass resonant
filter by removing the frequency component of a signal located below the cutoff frequency while
leaving those above the cutoff frequency unchanged. Similarly to the low-pass filter, the Q-factor
controls the emphasis of frequencies located around the cut-off frequency.

4.11.3 Band-Pass Filter
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Figure 27: Frequency response of the band-pass filter.

The behavior of a band-pass filter is to let the frequencies in a band located around a center
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frequency and to attenuate the frequencies outside of this band as shown in Figure 27. The band-
width of the band-pass filter is set with the Q knob while the center frequency is set with the Cutoff
knob. The Order control sets the order of the filter. This parameter affects the slope of the roll-off
on both sides of the center frequency. For a second order filter the slope is -6dB/Oct while for a
fourth order filter it is -12dB/Oct.

4.11.4 Notch Filter
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Figure 28: Frequency response of the notch filter.

The notch filter does essentially the opposite of the band-pass filter. It attenuates the frequencies
in a band located around the center frequency and leaves those outside of this band unchanged as
shown in Figure 28. The Cutoff knob is used adjust the center frequency and the Q knob sets the
bandwidth of the notch. Note that the center frequency is totally removed from the spectrum of the
output signal of the filter.

4.11.5 Formant Filter

The formant filter reproduces the filtering effect of the vocal tract in the human voice. By changing
the position of the tongue, the opening of the mouth and opening or closing the nasal cavities one
can change the filter applied to the glottal signal and thus produce the different vowels. Measure-
ments have shown that this filter can be modeled by three peaking EQ filters corresponding to the
three main cavities of the vocal tract as shown in Figure 29 and also known as formants. By mov-
ing the parameters of these three filters (frequency, amplitude and Q-factor) one can cycle between
all the vowels. The effect of the Cutoff knob on the formant filter is to offset all the formants by
the same factor and it is used to switch between male voice (left position), female voice (center)
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Figure 29: Frequency response of the formant filter.

and child (right position). The Q knob is used to cycle between vowels. Note that changing these
parameters can be automated by using the different modulation signals.

4.12 The Filter Env Module

The Filter Env envelope generator module is based on a standard
ADSR (attack, decay, sustain, release) approach including velocity
modulation.

The envelope module generates a four-segment envelope: attack,
decay, sustain, release. The attack time is adjusted using the A knob.
The attack time can also be modulated with the velocity signal received from the Keyboard in
such a way that that the higher the velocity signal the shorter the attack time will be, the intensity
of this effect being controlled using the modulation knob below of the A knob. When the knob
is in its leftmost position, the attack is only determined by the value of the A knob, turning the
knob clockwise will increase the influence of the velocity signal until the attack time is strictly
determined by the inverse of the velocity signal when V reaches its maximum value. The decay
time is set with the D knob. The sustain phase of the envelope generator lasts from the end of the
decay phase until the key is released. When the S knob is fully turned to the left, the sustain level
is zero and there is no sustain phase while fully turned to the right, the sustain level is at maximum
and there is no decay phase. Note that the sustain phase can also be modulated with the velocity
signal from the keyboard. Finally, when the key is released, the envelope generator toggles to the
release phase and the envelope signal decreases from its sustain level to zero in a time set by the R
knob.
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Figure 30: Response curve of an envelope generator

4.13 The LFO Module

The LFO module is used as a modulation source for the Filtermod-
ule. On the LFOmodule, one can adjust the waveform, rate and fade-in
behavior.

4.13.1 Wave Shape

The waveform of the LFO is selected with the Shape drop-down menu.
The possible values are Sine for sinus, Tri for triangular, Rect for rect-
angular and Rdm1 and Rdm2 for the two random modes. When the
Shape control is set to Rdm1, the LFO outputs random values at the rate determined by the Sync
control or the Rate knob. In this case, the output value from the LFO remains constant until a new
random value is introduced. The Rdm2 mode reacts almost like the preceding mode except that the
LFO module ramps up or down between successive random values instead of switching instantly
to the new value.
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4.13.2 Rate

There are two ways to adjust the rate, or frequency, of the output of the LFO module. If the Sync
control is in its off position, the rate is fixed with the Rate knob. When the Sync control is on,
the frequency of the oscillator is fixed relative to the frequency (tempo) of the master clock (see
4.18.1) and the value displayed in the Sync control. Sync values range from 1/8 of a quarter note
(a thirty-second note) to 16 quarter notes (4 whole notes) where the duration of the whole note is
determined by the value (in BPM) appearing in the Tempo display of the Clock module. The LFO
module can also be synced to a triplet (t) or a dotted note (d). Note that when the Sync control is
depressed, the Rate knob has no effect.

4.13.3 Fade-In

One more feature of the LFO module is the possibility to add a fade-in effect to its output signal
or in other words to set the amount of time necessary for the amplitude of the LFO signal to grow
from zero to its maximum value. The duration of this fade-in can be adjusted within the range of
0 to 5 seconds, as determined by the Fade knob. Turning this knob fully to the left results in a
value of 0 which is equivalent to removing the fade-in effect. The time at which the LFO signal is
introduced can even be controlled by adding a delay to the fade in. This parameter can also be set
to values varying between 0 and 5 seconds, as determined by the Delay knob. Note that this knob
is effective even if the Fade value is adjusted to zero. In this case, the signal from the LFO module
will simply be delayed.

Time
Delay

Fade in

Amplitude

Figure 31: Fade in feature of the LFO.
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4.14 The Keyboard Module

The Keyboard module controls how the synthesizer voices
respond to the events coming from an external MIDI keyboard
or from a MIDI sequencer. The first row of controls (Tuning,
Oct, Semi) is used to fix the pitch of the keyboard, and transpose
the overall keyboard by octaves or semi-tones. The Stretch and
Error knobs, on the bottom row, allow one to stretch the octaves
and/or add a random error on each note played. The second line
of parameters allows one to turn unison on or off, select the poly-
phonic or monophonic mode of operation, and choose the note priority. The first two knobs on the
third row, Detune and Decay, are used to set the detune amount and the time delay respectively
between voices of a note when the Unison mode is selected.

4.14.1 Tuning

The pitch of A4 (normally 440 Hz) is adjusted, in Hertz, in the Tuning display. The pitch can be
transposed by −3 to +3 octaves and −12 to +12 semi-tones by using the Octave and Semi drop-
down menus. Once the tuning of the keyboard has been determined trough the use of these three
controls, one can slightly alter it with the Stretch and the Error knobs. The Stretch knob sets the
value of a semi-tone. When in the center position, the semi-tone interval corresponds to that of the
equal-tempered scale. Turning the knob to the left shrinks the interval while turning it to the right
increases it. The main effect of the Stretch control is that when it is not in the center position, an
interval of one octave will not sound perfectly in tune and therefore beating will be heard when
playing perfect octaves. The Error knob adds a random error to each note played; the more the
knob is turned clockwise, the larger is the error. This will make all the notes play slightly out of
tune. Note that the sustain pedal (MIDI controller number 64) is always active on the Keyboard
module.

4.14.2 Mode and Priority

The keyboard can be monophonic, allowing one to play only one note at a time, or polyphonic,
allowing one the play chords. This behavior is adjusted with the Mode drop-down menu. The
Priority control, located on the right of the Mode control, sets the behavior of the keyboard when
several notes are depressed at the same time in monophonic mode or when the maximum number
of polyphonic voices has been reached in polyphonic mode. In monophonic mode, the Priority
determines which of the lower, last, or higher note has precedence when several notes are played.
In polyphonic mode, this control determines which of the lowest, highest, or oldest note is muted
in order to replace it with the newest note played once the maximum of polyphonic voices has been
reached. Note that since this parameter determines the note priority, the stolen note will be the
opposite of what appears in the control display.
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4.14.3 Unison

The unison mode allows one to stack voices, in other words, play two or four voices for each note
played on the keyboard. This mode creates the impression that several instruments are playing the
same note together, adding depth to the sound.

Each voice can be slightly detuned relative to the others by moving the Detune knob clockwise.
Furthermore, voices can be desynchronized by adding a small time lag between their triggering
with the Delay knob. This delay is nil when the knob is in its leftmost position and increased by
turning it clockwise.

4.15 The Portamento Module

The portamento effect is used to make the pitch slide between notes
rather than changing immediately from note to note. The Time knob
sets the amount of time it will take for the pitch to slide over one octave.
TheMode drop-down menu enables one to choose between the Constant
or Proportional mode. When in Constant mode, the time necessary
for the pitch to slide from one note to another will always be the same
regardless of the interval between the notes. When set to proportional, the slide time will be
proportional to the width of the interval between the two notes. When the portamento is on, the
slide effect occurs between every note.

Clicking on the Legato button will switch the module into legato mode and the sliding between
two notes will only occur if the second note is played before the first one is released. When a note is
played staccato, or in other words if a key is released before the next one is depressed, there will be
no portamento effect. Note that even though the portamento effect is available when theKeyboard
module is in polyphonic mode, it is mostly dedicated to monophonic playing. In polyphonic mode,
the sames rules will apply to individual voices and the overall result will be less predictable.

4.16 The Vibrato Module

The vibrato effect is equivalent to a periodic low frequency pitch
modulation. This effect is generally obtained by using an LFO to
modulate the pitch signal of a signal generator. In String Studio, a
dedicated module is provided for this effect.

The Rate knob sets the frequency of the vibrato effect from 0.5
Hz to 5 Hz. The Amount knob sets the depth of the effect, or in
other words the amplitude of the frequency variations. In its leftmost
position, there is no vibrato and turning the knob clockwise increases the amount of pitch variation.
The MW gain knob is used to determine the effect of the keyboard modulation wheel on the depth
of the vibrato. When this knob is fully turned to the left, the modulation wheel has no effect but
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when it is turned clockwise the depth of the vibrato will increase when the modulation wheel is
used. The increase is always relative to the position of the Amount knob and will be greater as the
Mod knob is turned clockwise.

The vibrato can be adjusted not to start at the beginning of a note but with a little lag. This
lag is set by the Delay knob. The Fade knob allows you to set the amount of time taken by the
amplitude of the vibrato effect to grow from zero to the amount set by the Amount knob.

The last parameter is used to add liveness to the sound. When several musicians play together,
they do not necessarily start their vibrato exactly at the same time, speed and amplitude. The
Error knob is used to produce this effect by adding an error to the Rate, Amount, Delay and Fade
parameters of the vibrato of each polyphonic voice. As the Error knob is turned clockwise, the
larger will be the difference between the vibrato effect applied to each voice. In its leftmost position
there is no added error and all the voices are played with exactly the same vibrato effect.

4.17 The Arpeggiator Module

The Arpeggiator module allows one to play sequentially all the
notes that are played on the keyboard. In other words, arpeggios
are played rather than chords. The modules allows one to produce
a wide range of arpeggios and rhythmic patterns and to sync the
effects to the tempo of an external sequencer.

4.17.1 Arpeggio Patterns

The arpeggio pattern is set by the combination of the value of the
Range, Span andOrder controls. The Range control is used to select
the number of octaves across which the pattern will be repeated. When the range is set to 0, there is
no transposition and only the notes currently depressed on the keyboard are played. If set to a value
between 1 and 4 (its maximum value), the notes played are transposed and played sequentially, over
a range of one or more octaves depending on the value of the Range parameter. The direction of
the transposition is set with the Span drop-down menu. This parameter can be adjusted to Low for
downwards transposition, to High for upwards transposition or Wide for transposing both upwards
and downwards. Finally, the Order control sets the order in which the notes are played, therefore
determining the arpeggio pattern. When set to Forward, the notes are played from the lowest to
the highest. When set to Backward the notes will be played from the highest to the lowest. In
the two last modes, Rock and Roll exclusive and Rock and Roll inclusive, the note will be played
forward from the lowest to the highest and then backward from the highest down to the lowest.
When using the RnR exclusive mode, the highest and the lowest notes will not be repeated when
switching direction but in RnR inclusive mode these notes will be repeated.



4.18 The Output Effect Section 49

4.17.2 Rhythmic Patterns

The rhythmic pattern is shown on the Pattern display. Different rhythmic presets are available
through the utility menu. Notes will be played as the 16-step display is scanned and the corre-
sponding step is selected (green button on). The little arrow on the top of the display is used to fix
looping points from which the rhythmic pattern will start being played again from the beginning.
Note that when a preset pattern is edited and then the Save Preset command from the File menu
is used, the modified pattern will be saved and reloaded when the corresponding preset is later
selected.

4.17.3 Rate and Synchronization

The rate at which the arpeggiator pattern is scanned is set by the Rate knob or can be synced to the
master clock of the Clock module. The Rate knob will only be effective when the Sync control is
set to Off. When the Sync control in on, the rate is fixed relative to the frequency (tempo) of the
master clock (see 4.18.1) and the value displayed in the Sync control. Sync values range from 1/8
of a quarter note (a thirty-second note) to 16 quarter notes (4 whole notes) where the duration of
the whole note is determined by the value (in BPM) appearing in the Tempo display of the Clock
module. This effect can also be synced to a triplet (t) or a dotted note (d).

4.17.4 Latch mode

The Arpeggiator module is toggled in latch mode by clicking the Latch button to the on position.
In this mode, the Arpeggiator will keep playing its pattern when the notes on the keyboard are
released and until a new chord is played.

4.18 The Output Effect Section

The output effect stage is located at the top row of Panel A of String Studio. This effect stage
allows one to add effects to the sound and record performances on the fly as wave or aiff files and
to synchronize different modules with a host sequencer.
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4.18.1 The Clock Module

This module is used to control the tempo of the different effects of the output section as well as
that of the LFO and Arpeggiator modules. The Source drop down menu is used to determine if
the sync signal comes from an external source or from the internal clock of the module. The Tempo
display indicates the value of the tempo in BPM (beats per minute). When String Studio is used as
a plug-in in a host sequencer and the Ext source is chosen, the clock signal will be that sent by the
host sequencer while in standalone mode the clock will be the one received on the MIDI channel
selected in the toolbar.

When the Int source is chosen, the tempo is determined by the value of Tempo display. The
tempo can also be changed by clicking repeatedly on the Tap pad of the Tempo display which will
update the value of the tempo in the Tempo display.

Note that the settings of the Clock module are saved with presets. In order for the Clock
module to remain in a specific state even when loading new presets, click on the Lock icon at the
top of the module.

4.18.2 The Chorus Module

This module implements both a chorus and a flange effect consists of four variable delay lines in
parallel with a cross-feedback matrix between the lines. A wide range of effects is obtained by
modulating the length of the lines and varying the amount of cross-feedback.

TheChorus drop down menu is used to choose between different chorus and flanger algorithms.
The effect can be synchronized to the Clock module with the Sync drop-down menu. Sync values
range from 1/8 of a quarter note (a thirty-second note) to 16 quarter notes (4 whole notes) where
the duration of the whole note is determined by the value (in BPM) appearing in the Tempo display
of the Clock module. The effect can also be synced to a triplet (t) or dotted note (d).

The different chorus algorithms can be controlled with the three knobs appearing at the bottom
of the module. The Mix knob is used to adjust the ratio of “dry” and “wet” in the output signal of
the module. When the knob is adjusted in the left position, only the original or “dry” signal is sent
to the output while in the right position only the processed or “wet” signal is sent to the output. In
its center position there will be equal amounts of “dry” and “wet” signal in the output signal. The
Depth knob is used to adjust the amount of variation of length in the delay lines which controls the
amplitude of the effect while the Rate knob is used to fix the frequency of the modulation.

4.18.3 The Delay Module

This module is a standard ping pong delay which is used to generate echo. It is based on two delay
lines each including a low-pass filter. The effect is obtained by feeding back the signal at the end of
each delay line into the input of the other line with an attenuation coefficient. The result is a signal
traveling from one channel to the other, each time attenuated and filtered in the high frequencies
due to the gain factor and the presence of the low-pass filter.
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The Delay drop down menu is used to choose between different delay algorithms. The effect
can be synchronized to the Clock module with the Sync drop-down menu. Sync values range from
1/8 of a quarter note (a thirty-second note) to 16 quarter notes (4 whole notes) where the duration
of the whole note is determined by the value (in BPM) appearing in the Tempo display of the Clock
module. The effect can also be synced to a triplet (t) or dotted note (d).

The different delay algorithms can be controlled with the three knobs appearing at the bottom
of the module. The Mix knob is used to adjust the ratio of “dry” and “wet” in the output signal of
the module. When the knob is adjusted in the left position, only the original or “dry” signal is sent
to the output while in the right position only the processed or “wet” signal is sent to the output. In
its center position there is equal amounts of “dry” and “wet” signal in the output signal. The Depth
knob is used to adjust the amount of signal re-injected from the output of a line into the other one
while the Rate knob controls the length of the delay lines and therefore the delay between echoes.

4.18.4 The Reverb module

The Reverb module is used to recreate the effect of reflections of sound on the walls of a room or
hall. These reflections add space to the sound and make it warmer, deeper, as well as more realistic
since we always listen to instruments in a room and thus with a room effect.

The Reverb drop down menu is used to choose between different reverb algorithms representing
different types of rooms or halls. Each algorithm can be adjusted with the knobs located at the
bottom of the module. The Mix knob is used to set the relative amount of “dry” and “wet” signal
which is related to the proximity of the sound source. TheDecay is used to control the reverberation
time of the room. In a real room, the reverberation time is not constant across the whole frequency
range because the walls of the hall are generally more absorbent at high frequencies which results
in a shorter reverberation time for these frequencies. This effect is controlled with the Color knob
which sets the reverberation time of high frequencies relatively to the value of the Decay knob.

Note that the settings of the different modules of the output stage are saved with presets. In
order for the effects to remain with the same settings even when loading new presets, click on the
Lock icon at the top of the module.

4.18.5 Topology

The three effects of the output section can be used in four different configurations as shown in
Figure 32 and where the Chorus, Delay and Reverbmodules are labeled A, B, and C respectively.

Figure 32: The four topologies in which the effects can be applied after the Amp module of the
two module rows; A = Chorus module, B = Delay module and C = Reverb module.
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In the first configuration, the Chorus module is first applied, then the Delay and finally the
Reverb module. In the second configuration, the signal is first processed by the Delay, then by the
Chorus and the Reverb module.

Note that each of the effects can be muted by selecting the Bypass preset in its respective
algorithm selection drop down menu.

4.18.6 The Output Module

This module is used to monitor levels of the left and right channels. It is located at the of Panel A
and Panel B. The overall level is adjusted with the Level knob. The best dynamic range is obtained
when the level meters are around 0 dB for loud sounds.

4.18.7 The Recorder Module

This module is used to record the output of String Studio to a stereo 16-bit wave or aiff file. The
File display, is used to choose the name and location of the destination file. One should always use
this before starting a recording. The Rec and Stop buttons are used to start or stop the recording.
On Windows systems the sampling rate will match that of the Audio Settings of the Preferences
command of the Edit menu. On Mac systems, the specific settings are determined by QuickTime.
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5 Toolbar

The toolbar at the top of the String Studio interface allows you to monitor important information
related to your current set-up.

5.1 Preset Display

Displays the name of the currently opened preset. The + and − buttons on the right of the preset
name, or alternatively the + and − keys on the computer keyboard, are used to navigate upwards
and downwards in the preset hierarchy as found in the browser. When a preset is modified, the
preset icon to the left of the preset name will change color in order to indicate that saving is
necessary in order not to loose the changes that have been applied.

5.2 MIDI map

Displays the name of the currently opened MIDI map. For more information on MIDI maps, please
refer to Section 6.2.

5.3 Polyphony Combo Box

Displays the number of voices of polyphony (2 to 32). The number of voices can be adjusted with
the drop down menu from the combo box.

5.4 MIDI Channel combo box

Displays the current MIDI channel on which String Studio is receiving MIDI information. The
channel can be adjusted with the drop down menu from the combo box.

5.5 Value Display

Displays the value of the currently selected control on the interface. The values range from 0 to
127 for knobs and 0 or 1 for buttons depending on whether they are in their on or off position.

5.6 CPU meter

Percentage of the total CPU resources currently used by String Studio.
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5.7 MIDI LED

The red MIDI LED toggles when a MIDI signal is received by the String Studio. This is very useful
to see if String Studio is receiving MIDI signal from your keyboard or other controllers. If the LED
does not blink when you play your keyboard, check your connections and the transmit/receive
channels you are using or the MIDI settings of String Studio as explained in Section 6.2.
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6 Audio and MIDI Settings

This chapter explains how to select the audio and MIDI devices used by String Studio as well as
how to create and edit MIDI links and MIDI maps. When referring to commands that are different
on Windows and Mac OS systems, the commands are listed in the following order: Windows
command/Mac OS command.

6.1 Audio Device Settings

To select the audio device used by String Studio:

• Go to the Edit menu, choose Preferences and then Audio Settings. On Mac OS, the same
command is under the String Studio menu. A list of the audio devices installed on your
computer will appear in the Audio Configuration window.

• Click on the audio device you wish to use and click on the OK button.

6.2 MIDI Settings

6.2.1 Selecting a MIDI Device

To select the MIDI device used by String Studio:

• Go to the Edit menu, choose Preferences and then MIDI Settings. On Mac OS, the same
command is under the String Studio menu. A list of the MIDI devices installed on your
computer will appear in theMIDI Configuration window.

• Select the MIDI device you want to use and click on the OK button.

6.2.2 Creating MIDI Links

Every control on the String Studio interface can be manipulated by an external MIDI controller.
In most cases this is much more convenient than using the mouse, especially if you want to move
many controllers at once. For example, you can map the motion of a knob on the interface to a
real knob on a knob box or to the modulation wheel from your keyboard. As you use the specified
MIDI controllers, you will see the controls move on the String Studio interface just as if you had
used the mouse.

To assign a MIDI link to a controller:

• On the interface, right-click/Control-click on a control (knob, button), a contextual menu
appears. Select Learn MIDILink.
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• Move a knob or slider on your MIDI controller (this can be a keyboard, a knob box, or any
device that sends MIDI). This will link the control of the String Studio to the MIDI controller
you just moved.

MIDI links can also be created in the MIDI Links window which is launched by choosing the
Edit MIDILinks command from the Edit menu or by right-clicking/Control-click on any control
and choosing the Edit MIDILinks command.

• Click on New to create a new MIDI link.

• The MIDI controller number specified in the Controller textbox is set by default to a value
of 1. This is the MIDI controller number corresponding to the modulation wheel. If you
want to assign a new controller to the knob, specify the number here.

• You can also assign a different MIDI channel to the controller in the Channel textbox. By
default this value will be set to channel 1.

6.2.3 Editing MIDI Links

MIDI links can be edited in the MIDI Links window, which lists all the currently available MIDI
links.

• To edit the MIDI link, right-click/Control-click again on the control and chooseEditMIDILinks
to open the MIDI links window. You can also use the Edit MIDILinks command from the
Edit menu.

• Click on the MIDI link you wish to modify and then on the Edit button to launch the EDIT
MIDI Link window.

• Choose the parameter controlled by the current MIDI link from the Parameter drop-down
menu which lists all the parameters of the current module.

• Specify the MIDI controller number and MIDI channel of the physical controller you wish
to link to the parameter in the corresponding textboxes.

• You can also adjust the Minimum Value and Maximum Value of the controller, which
are used to limit the range of MIDI controllers. The Minimum Value field determines the
position on the String Studio control which corresponds to the minimum value sent by the
MIDI controller; the Maximum Value determines the position which corresponds to the
maximum value sent by the MIDI controller. A value of 0 corresponds to the String Studio
control minimum position (left position for a knob) and a value of 1 to the String Studio
control maximum position (right position for a knob).

• Note that the range of a knob can be inverted by setting the value of Maximum Value to a
smaller value than that of Minimum Value. This can be useful, for example, if you want to
control the cutoff and the resonance of a filter with the same knob but you want the resonance
to increase as the cutoff decreases.
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• Click on the OK button and the link appears in the list of controllers linked to the control.

• Click on the OK button again to confirm the change and to leave the MIDI Links window.

• Note that the Minimum Value and Maximum Value of a MIDI link can also be set by
right/control clicking on the corresponding control and selecting the Set MidiLink Mini-
mum Value or Set MidiLink Maximum Value command. The value corresponding to the
control position will then be saved as the minimum or maximum value of the MIDI link.

6.2.4 Deleting MIDI Links

• To remove a MIDI link, right-click/Control-click again on the control and choose Forget
MIDILinks.

• MIDI links can also be removed from the MIDI Links window by clicking on the MIDI link
to be removed to select it, then by clicking on the Remove button and the OK button to
confirm the change.

6.2.5 Creating a MIDI Map

A set of MIDI links can be saved into a MIDI map by using the Save MIDI Links As from the
File menu. Different MIDI maps corresponding to different MIDI controllers can thereby be saved
for String Studio. A MIDI map can be loaded by double clicking on the corresponding MIDI
connector icon that appears in the browser when a MIDI map is saved. Furthermore a MIDI map
can be loaded automatically when an instrument is launched.

• To assign a default MIDI map, right-click/Ctrl-click on the MIDI map icon and choose the
MIDI Link Info command. In the Edit Information Window, select theMark As Default
option.

6.2.6 Creating the MIDI Program Change Map

MIDI program changes can be used to switch between presets while playing. To associate a pro-
gram change to a preset:

• Choose Edit Program Changes from the Edit menu.

• The browser view and the list of presets appears to the left of the ProgramChangeswindow,
while the program change table appears to the right. The Program Changes table lists the
program numbers (from 1 to 128) and their corresponding presets.

• To associate a preset to a given program change, click on the preset icon in the browser and
drag-and-drop it on the selected line of the program change table.

• To unassign a program change, right-click/Ctrl-click on the preset name to the right of the
Program Changes window and click on unassign.
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6.3 Audio Control Panel

To launch the audio configuration panel, choose Audio Control Panel under Preferences of the
Edit menu on Windows or the String Studio menu on Mac OS systems.

This panel allows you to select the bit depth sample rate (22.05, 44.1, 48, or 96 kHz) and buffer
size, which affects how quickly String Studio responds to the control information it receives. The
smaller the buffer size, the shorter the latency, and vice versa. Note that the content of the dialog
depends on the driver selected in the Audio Settings menu.

Some sound cards provide their own ASIO control panel, in which case the above information
will differ from card to card. Some sound cards also require that you close all programs before
making changes to the buffer size or sampling rate. If you discover this is the case with your sound
card, please refer to the manufacturer’s documentation for details on configuring it for optimum
performance. Most sound card manufacturers also update their drivers regularly. It is strongly
recommended that you visit your sound card manufacturer’s website regularly to ensure you are
using the most up to date drivers and support software.

6.4 Latency Settings

The latency is the time delay between the moment you send a control signal to your computer (for
example when you hit a key on your MIDI keyboard) and the moment when you hear the effect.
Roughly, the latency will be equal to the duration of the buffers used by the application and the
sound card to play audio and MIDI. To calculate the total time required to play a buffer, just divide
the number of samples per buffer by the sampling frequency. For example, 256 samples played
at 48 kHz represent a time of 5.3 ms. Doubling the number of samples and keeping the sampling
frequency constant will double this time while changing the sampling frequency to 96 kHz and
keeping the buffer size constant will reduce the latency to 2.7 ms.

It is of course desirable to have as little latency as possible. String Studio however requires a
certain amount of time to be able to calculate sound samples in a continuous manner. This time
depends on the power of your computer, the preset played, the sampling rate, and the number of
voices of polyphony used. Note that it will literally take twice as much CPU power to process
audio at a sampling rate of 96 kHz as it would to process the same data at 48 kHz, simply because
you need to calculate twice as many samples in the same amount of time.

Depending on your machine you should choose, for a given sampling frequency, the smallest
buffer size that allows you to keep real-time for a reasonable number of voices of polyphony. To
adjust these parameters:

• Launch the Audio Control Panel

• Choose the sampling frequency and the audio format (16, 24, 32 bits)

• Adjust the buffer size
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In order to optimize the resources allocated to the calculation of audio by String Studio, it is
possible to decrease the ratio of resources devoted to the calculation of graphics for the interface
in favor of audio related calculations. To adjust this ratio, choose the General command under
Preferences in the Edit menu on Windows or String Studio menu on Mac OS and adjust the Per-
formance slider to the desired value between better audio performance and smoother graphics.
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7 Using the String Studio as a Plug-In

String Studio is available in VST, DXi, AudioUnit and RTAS (for Mac OS only) formats and
integrates seamlessly into the industry most popular multi-track recording and sequencing envi-
ronments as a virtual instrument plug-in. The plug-in versions will work exactly the same way as
the standalone version, except for the audio, MIDI, and latency configurations that will be taken
care of by the host sequencer. Furthermore String Studio works as any other plug-in in these en-
vironments so we recommend that you refer to your sequencer documentation in case you have
problems running String Studio as a plug-in. We review here some general points to keep in mind
when using a plug-in version of String Studio.

7.1 Window Size

The size of the String Studio window is fixed as in the standalone version. It is possible, however,
to gain some space on the screen by using the Hide Browser command from the View menu in
order to hide the browser.

7.2 Synchronization to the Host Sequencer

To synchronize String Studio with the clock of a host sequencer, select the External Source option
in the Source drop down menu of the Clock module and make sure that the Sync control of the
Effects, LFO and Arpeggiator modules are set to their On position.

7.3 Audio and MIDI parameters

When String Studio is used as a plug-in, the audio and MIDI ports, sampling rate, buffer size, and
audio format are determined by the host sequencer.

7.4 Automation

String Studio supports automation functions of host sequencers. Automation can usually be done
by using MIDI links and recording MIDI events, or by recording the motion of controls on the
interface.

7.5 Multiple Instances

Multiple instances of String Studio can be launched simultaneously in a host sequencer.
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7.6 Saving Projects

When saving a project in a host sequencer, information on the position of all the controls on the
interface, the MIDI links, and the preset name are saved. Note that if the preset was modified after
it was loaded, the original version of the preset is not overwritten.

7.7 MIDI channel

Make sure that the MIDI controller, sequencer and String Studio all use the same MIDI channel.

7.8 MIDI program change

MIDI program changes are supported in the plug-in versions of String Studio. Note that with the
VST format, the list of program changes is available in the host program’s VST program list and
the Edit Program Changes command is not available.

7.9 Performance

Using a plug-in in a host sequencer requires CPU processing for both applications. The load on the
CPU is even higher when multiple instances of a plug-in or numerous different plug-ins are used.
To decrease CPU usage, remember that you can use the freeze of bounce to track functions of the
host sequencer in order to render to audio the part played by a plug-in instead of recalculating it
every time it is played.
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8 Quick reference to commands and shortcuts

File Menu

Command Windows Mac OS Description

New Folder. . . Apple+Shift+N New Folder in the
Browser

Open Preset Ctrl+O Apple+Option+O Open the selected preset

Save Preset Ctrl+S Apple+S Save the current preset

Save Preset As. . . Save the current preset under
a new name

Save MIDI Links Ctrl+Shift+S Apple+Shift+S Save the current MIDI
links

Save MIDI Links As. . . Save the current MIDI links
under a new name

Import. . . Import a .axf file

Export. . . Export a .axf file

Exit (Quit on Mac) Quit the application
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Edit Menu

Command Windows Mac OS Description

Undo Ctrl+Z Apple+Z Undo last command

Redo Ctrl+Y Apple+Shift+Z Redo last command

Cut Ctrl+X Apple+X Cut selected item

Copy Ctrl+C Apple+C Copy selected item

Paste Ctrl+V Apple+V Paste

Delete Del Delete selected item

Select All Ctrl+A Apple+A Select all items

Get Info. . . Ctrl-I Apple+I Edit information about a
selected item (browser)

Compare Compare modified preset
with original settings

Learn MIDILink Enter MIDI link learn mode
(player)

Forget MIDILink Drop a MIDI link (player)

Set MIDILink Minimun
Value

Limit the value of a MIDI
link to a minimum value

Set MIDILink Minimun
Value

Limit the value of a MIDI
link to a maximum value

Edit MIDIlinks Display the Edit MIDI links
window to view or edit MIDI
links of the current patch

Edit Program Change. . . Associate presets with MIDI
program changes
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Edit/Preferences Menu on Windows, String Studio/Preferences on Mac OS

Command Windows Mac OS Description

General Display the Edit General Preferences
window

Audio Settings Display the Audio Settings window

MIDI Settings Display the MIDI Settings window

Audio Control Panel Display the Latency Settings window

View Menu

Command Windows Mac OS Description

Show/Hide Browser Apple-B Show/Hide the browser panel

Locate Ctrl-L Apple-L Locate the current preset in the
browser and select it

Help Menu

Command Windows Mac OS Description

Manual F1 Display the user manual

About String Studio Display the About String Studio
window
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9 License Agreement

IMPORTANT! CAREFULLY READ ALL THE TERMS AND CONDITIONS OF THIS AGREE-
MENT BEFORE OPENING THIS PACKAGE. OPENING THIS PACKAGE INDICATES YOUR
ACCEPTANCE OF THESE TERMS AND CONDITIONS. IF YOU DO NOT AGREE WITH
THE TERMS AND CONDITIONS OF THIS AGREEMENT, PROMPTLY RETURN THE UN-
OPENED PACKAGE AND ALL COMPONENTS THERETO TO THE PARTY FROM WHOM
IT WAS ACQUIRED, FOR A FULL REFUND OF ANY CONSIDERATION PAID.

This software program, any printed materials, any on-line or electronic documentation, and any
and all copies of such software program and materials (the “Software”) are the copyrighted work
of Applied Acoustics Systems DVM Inc. (“AAS”), its subsidiaries, licensors and/or its suppliers.

1. LICENSE TO USE. The Licensee is granted a personal, non-exclusive and non-transferable
license to install and to use one copy of the Software on a single computer solely for the
personal use of the Licensee. Use of the Software is subject to this Agreement.

2. RESTRICTIONS ON USE. The Licensee may not nor permit third parties to (i) make copies
of any portion of the Software, other than as expressly permitted under this Agreement; (ii)
modify, translate, disassemble, decompile, reverse engineer or create derivative and/or com-
petitive products based on any portion of the Software; (iii) provide use of the Software in a
network, timesharing, interactive cable television, multiple CPU service bureau or multiple
user arrangement to users not individually licensed by AAS, other than as expressly permit-
ted by the terms of this license. The Software is licensed to you as a single product. Its
component parts may not be separated for use on more than one computer.

3. OWNERSHIP. AAS retains title to the Software, including but not limited to any titles,
computer code, themes, objects dialog concepts, artwork, animations, sounds, audio effects,
methods of operation, moral rights, any related documentation and “applets” incorporated
into the Software. AAS retains ownership of and title to all intellectual property rights in the
Software, underlying technology, related written materials, logos, names and other support
materials furnished either with the Software or as a result of this Agreement, including but
not limited to trade secrets, patents, trademarks and copyrights therein. Licensee shall not
remove or alter any copyright or other proprietary rights notices contained on or within the
Software and shall reproduce such notices on all copies thereof permitted under this Agree-
ment or associated documentation.

4. LIMITED WARRANTY. Except for the foregoing, THE SOFTWARE IS provided “AS IS”
without warranty or condition of any kind. AAS disclaims all warranties or conditions, writ-
ten or oral, statutory, express or implied, including but not limited to the implied warranties of
merchantable quality or fitness for a particular purpose, title and non-infringement of rights
of any other person. AAS does not warrant that THE SOFTWARE will meet the Licensee’s
requirements or that the operation of the software will be uninterrupted or ERROR-FREE.
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5. LIMITATION OF LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLI-
CABLE LAW, IN NO EVENT WILL AAS BE LIABLE TO THE LICENSEE OR ANY
THIRD PARTY FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL
OR EXEMPLARY DAMAGES WHATSOEVER, INCLUDING BUT NOT LIMITED TO
LOSS OF REVENUE OR PROFIT, LOST OR DAMAGED DATA, BUSINESS INTER-
RUPTION OR ANY OTHER PECUNIARY LOSS WHETHER BASED IN CONTRACT,
TORT OR OTHER CAUSE OF ACTION, EVEN IF AAS HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES, EXCEPT IN RELATION TO GROSS NEGLIGENCE
OR WILFUL BREACH OF THIS AGREEMENT BY AAS. NO AAS AGENT, REPRE-
SENTATIVE OR DEALER IS AUTHORIZED TO EXTEND, MODIFY OR ADD TO THIS
WARRANTY ON BEHALF OF AAS. THE TOTAL LIABILITY OF AAS FOR DAM-
AGES, WHETHER IN CONTRACT OR TORT, UNDER OR RELATED IN ANY WAY TO
THIS AGREEMENT SHALL BE LIMITED TO THE LICENSE FEES ACTUALLY PAID
BY LICENSEE TO AAS, OR IF NO FEES WERE PAID, AAS’ LIST PRICE FOR THE
SOFTWARE COVERED BY THIS LICENSE. THE EXCLUSION OF IMPLIED WAR-
RANTIES AND/OR THE LIMITATION OF LIABILITY IS NOT PERMITTED IN SOME
JURISDICTIONS, AND SOME OR ALL OF THESE EXCLUSIONS MAY THEREFORE
NOT APPLY.

6. TERMINATION. This License also shall extend to the Software and any updates or new
releases thereof obtained by the Licensee, if any, subject to any changes to this License made
by AAS from time to time and provided to the Licensee, provided AAS is under a separate
obligation to provide to Licensee such updates or upgrades and Licensee continues to have a
valid license which is in effect at the time of receipt of each such update or new release. This
License shall remain in effect until terminated. The Licensee may terminate this Agreement
at any time, upon notification to AAS. This Agreement will terminate immediately without
notice from AAS if the Licensee fails to comply with any provision of this License. Any
such termination by AAS shall be in addition to and without prejudice to such rights and
remedies as may be available, including injunction and other equitable remedies. Upon
receipt of notice of termination from AAS, the Licensee must (a) immediately cease to use
the Software; (b) destroy all copies of the Software, as well as copies of all documentation,
specifications and magnetic media relating thereto in Licensee’s possession or control; and
(c) return all original versions of the Software and associated documentation. The provisions
of Sections 1, 3, and 5 shall survive the termination of this Agreement.

7. GOVERNING LAW. This Agreement shall be governed by and construed in accordance with
the laws of the Province of Quebec, without regard to the United Nations Convention On
Contracts for the International Sale of Goods and conflict of laws provisions, if applicable,
and the parties hereby irrevocably attorn to the jurisdiction of the courts of that province. Les
parties sont d’accord à ce que cette convention soit rédigée en langue anglaise. The parties
have agreed that this agreement be drafted in the English language.

8. SEVERABILITY. If any of the above provisions are held to be illegal, invalid or unenforce-
able, such provision shall be severed from this Agreement and this Agreement shall not be
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rendered inoperative but the remaining provisions shall continue in full force and effect.

9. ENTIRE AGREEMENT. This Agreement is the entire agreement between AAS and the
Licensee relating to the Software and: (i) supersedes all prior or contemporaneous oral or
written communications, proposals and representations with respect to its subject matter; and
(ii) prevails over any conflicting or additional terms of any quote, order, acknowledgement,
or similar communication between the parties during the term of this Agreement except as
otherwise expressly agreed by the parties. No modification to the Agreement will be binding,
unless in writing and signed by a duly authorized representative of each party.

10. NON-WAIVER. No delay or failure to take any action or exercise any rights under this
Agreement shall constitute a waiver or consent unless expressly waived or consented to in
writing by a duly authorized representative of AAS. A waiver of any event does not apply to
any other event, even if in relation to the same subject-matter.
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